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Intfroduction

Wind is the major disturbance factor in European forests and it is responsible for more than
50% of all damage by volume. The risk of wind damage is a significant constraint to forest
management in Britain. The first major storm to affect British commercial forests, since major
replanting started after World War |, was in 1953 in northeast Scotland. This has been followed
by major storms in 1968 (central Scotland), 1976 (Wales and central England), 1987 (southeast
England), 1990 (southwest England and south Wales), 2005 (northwest England and northwest
Scotland), and 2012 (central Scotland). Damage levels ranged from 0.5 to almost 4 million
cubic metres, representing up to five times the normal annual cut for the affected region.

Wind damage results in both direct costs (e.g. the additional cost of harvesting) and indirect
costs (e.g. loss of amenity). It impacts on silvicultural practice by restricting thinning and
shortening rotations, and it can lead to precautionary felling in forests at risk of windthrow

in many parts of the country. Wind damage is of particular concern on exposed sites or sites
with soils that restrict the rooting depth of trees. Windthrow is normally the main form of
damage, but wind snap can be locally important when trees are particularly well anchored.
Good forest management can significantly reduce the vulnerability of a forest to wind damage.
However, in order to manage and minimise risk, forest managers need information on the
likely timing and magnitude of damage so that they are able to predict the level of risk,

and assess the implications of different management options.

The Forest GALES software

Forest GALES is a computer-based decision support system that assesses the risk of wind
damage to conifer forests in Britain and compares the impacts of different silvicultural practices.
Forest GALES is recommended for use at forest scales, rather than for individual stands, because
of inherent variability in predictions. It is currently designed for use in stands of uniform age
and species. It works by calculating the wind speed at which damage is expected to occur,
based on stand and soil characteristics (the ‘critical wind speed’). It then uses this critical wind
speed and the wind climate (predicted from the stand location) to calculate the probability of
damage. The model calculates the risk for a representative ‘average’ tree within the stand and,
by implication, the stand as a whole.

Forest GALES calculates both the risk of overturning (windthrow) and stem breakage, allowing
managers to assess the likelihood of the different types of damage. For example, comparable
values of critical wind speeds indicate that similar proportions of overturning and breakage are
likely if damage occurs, whereas large differences (e.g. >5 m per second) would indicate much
higher levels of the damage type with the lower critical wind speed. Forest GALES also allows
the user to test the impact of standard thinnings or alternative thinnings defined by the user.
Forest GALES is the recommended tool for testing the impact of thinning in operational
guidance for Forestry Commission staff.

Updates and further information
For latest updates and on-line version of this manual, go to: www.forestry.gov.uk/forestgales

ForestGALES 2.5
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Background to the development of Forest GALES

Forest GALES is based on research conducted by the Forestry Commission and Forest Research
over the past 50 years. Version 2.5 represents over a decade of development since Version 1.0
was first published in 2000, and it contains significant improvements from Version 2.1 (published
in 2006). For example, there have been improvements in the way the model simulates the
gustiness of the wind, the description of tree crown characteristics, the classification of soil and
rooting, and the representation of the wind climate. In particular there has now been validation
of the model against wind damage in Cowal and Trossachs Forest District following a storm in
January 2012. Work is currently underway on prototype models that calculate the risk to every
individual tree within a stand, rather than an ‘average tree', and work with mixed structure and
species stands.

Prior to the availability of the Forest GALES software, strategies for minimising wind damage
were guided by the windthrow hazard classification (WHC) system, described in Forestry
Commission Leaflet 85 Windthrow hazard classification. This provided a method to zone forest
areas of 500 ha or more by adding scores for windiness and soil together to estimate a hazard
class. Although the WHC provided a successful basis for comparing sites and guiding decisions
on thinning, it did not predict the timing or amount of damage with acceptable accuracy.
Furthermore, it was not possible to test the influence of species choice or type of thinning.

For these reasons, Forest GALES has now replaced the WHC as the recommended decision
support tool for managing wind risk for forest management in Britain. However, it is possible to
calculate WHC in Forest GALES so that users can make comparisons between the two methods.

DAMS (Detailed Aspect Method of Scoring)

The average windiness of a site is measured using the DAMS system*. DAMS is based on
location, elevation and topographic exposure, and gives a good representation of both the
average wind speed and the frequency of strong winds at a site. Values of DAMS in Britain
typically range from 10 (sheltered) to 24 (exposed). Small differences in DAMS can result in
large differences in predictions of wind damage.

What's new in Forest GALES 2.57
Improved predictions

A study of wind damage following a storm at a site in the west of Scotland in 2012 compared
the damage predicted by Forest GALES and the actual damage that had occurred. This confirmed
users’ observations that Forest GALES 2.1 was pessimistic in its predictions of damage, i.e. it was
predicting more damage than actually occurred. This, coupled with new measurements of the
‘gustiness’ of wind in forests, has led to a reduction in the ‘gust factor’ used in the software. As a
result, the estimated critical wind speeds in Forest GALES 2.5 are higher, and stands are now
predicted to be more stable and at less at risk of damage. This is the most significant change
to the model output and largely over-rides differences introduced by the other changes
described below. For example, some thinnings that were restricted to sites with DAMS of 17 or
below might now be possible on sites with DAMS up to 19. Note that this is only a general
indication of the differences between ForestGALES 2.1 and Forest GALES 2.5; it is important
that each site is assessed individually with the new version of Forest GALES.

*QUINE, C.P.and WHITE, .M.S. (1994). Using the relationship between rate of tatter and topographic
variables to predict site windiness in upland Britain. Forestry 67, 245-256.



Change to inputs

The resistance to overturning (anchorage of a tree) in Forest GALES 2.1 was calculated using
information on soil type, cultivation and drainage. In Forest GALES 2.5, the effects of cultivation
and drainage have been combined and replaced by rooting depth. The grouping of soil types
within Forest GALES 2.5 has also changed. A Soil and rooting helper is now available to help
users choose the correct combination of soil and rooting for a given site. As a result of these
developments, the inputs to Forest GALES 2.5 have changed. However, overall there is no
substantial or systematic difference to the critical wind speed for overturning as a result of these
changes, and there is also less of a difference between soil types than there was in Forest GALES
2.1. Sites previously classed as having ‘poor’ or ‘good’ drainage will become slightly more and
less stable, respectively.

Crown size calculations

The calculations of crown size within Forest GALES 2.5 have been revised and are now based
on a much larger dataset than was previously available. For most species this makes little
difference. For Scots pine and Corsican pine, spuriously high values of critical wind speed
no longer occur. The larger dataset has produced substantially more robust calculations

of crown size for western hemlock, Douglas fir and lodgepole pine.

‘Normal  and ‘Research’ mode

Forest GALES 2.5 runs in two modes. The default 'Normal mode provides a standardised
version that should give the majority of users all the facilities they require to make wind risk
calculations and export results to Microsoft Word or Excel. The alternative ‘Research’ mode
has added features that make the software more flexible for research users. Species-specific
external parameter files make it easier to alter parameters such as crown relationships or
anchorage coefficients. New species can also be added. Weibull parameters (describing the
wind regime) can be entered directly rather than by being calculated from DAMS. A wide
range of outputs can now be saved to a file.

ForestGALES 2.5
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Installing Forest GALES

System requirements

* Windows® operating system (Windows® 3 to 8).

* 30 MB of available hard-disk space (if DAMS scores not installed on hard-disk) or 535 MB
for full installation.

The system requirements are minimal and Forest GALES makes no use of the Registry, in
order to reduce issues with Windows® security. In Windows® 7 and 8 there may be some
issues installing and running Forest GALES due to security settings (see box below). It is
recommended to have Microsoft® Excel and Word installed to help produce reports.
Results can be exported to Microsoft® Excel, Word or as ASCII text files.

A zipped directory containing DAMS values (approximately 240 MB) can be downloaded
from the Forest GALES website (www.forestry.gov.uk/forestgales) and extracted to anywhere
on your computer. DAMS values are unchanged from earlier versions of Forest GALES, so
existing DAMS CDs can also be used.

How to install Forest GALES

Forest GALES can be installed in two ways, depending on your computer’s security settings.

Method 1

(this should work on most computers):
=> Run the installation file called ForestGALES25 SetUp.exe.

By default the program will be installed into the directory C:\Program Files (x86)\Forest
Research\ForestGALES_2.5. However, it can be placed elsewhere if required during the
installation process. The installation program will automatically place all the files where they
are needed and add an option to run Forest GALES2.5 from the programs list (Figure 1), or
from the start screen in Windows® 8.

Figure 1 Programs list.

| | ForestGALES2.5
%) ForestGALES2.S
© Help ForestGALES2 5
ik Uninstall ForestGALES2.5 G

4 Back

Search programs and files P |

During installation you will be given information about copyright and the changes
in Forest GALES2.5 in comparison with previous versions.

Method 2

(if Method 1 does not work).
=> Unzip all the files required from the self-extracting file ForestGALES25_Extract.exe.

This file can be put anywhere on your hard disc. The only difference from Option 1 above
is that there is no dialog during extraction. You must read Readme.pdf or Readme.txt for

o

Users must agree to the
ForestGALES licence
agreement during
installation. The licence

agreement should be
printed and kept for
future reference and may
be viewed or printed

at any time from www.
forestry.gov.uk/forestgales.
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information on copyright, and the changes in Forest GALES2.5. This method does not make
a link to the programs list but you can add a shortcut to the desktop. An example shortcut
(ForestGALES25.Ink) is provided in the folder \ForestGALES_2.5\Templates, which links to
ForestGALES.exe extracted to the desktop. The shortcut must be placed on the desktop and
its target properties edited to match with the particular user and extraction location of
Forest GALES2.5 (Figure 2).

Figure 2 Shortcut settings.

£ ForestGALESIS exe Properties =
General Shorteut Compatibilty
g«:« Forest(3Al FS25 sve

Tamet tyne: Apphinatnn
Target location: Din
Target: search'\ForestGALES_2 5'Bin\ForestGALES exe”

Start in: "C-\Program Filee {xB6)\Forest Reesarch' ForeetG

Shortcut key:  Mone

Bun: | Nomal winciow v
Comment
Open File Location | | Changs lcon... i | Advanced...
| ok || Cancal Appy

Administration privileges in Windows® 7 and 8

The level of security has increased in Windows® 7 and 8 compared with previous
versions. This means that there can be problems in installing, running or saving files if
Windows® requires administrator rights. The installation program described in Method 1
above has been set up to try to minimise these problems and give the user control over
all the files in the installation file space. However, if you have any problems with lack

of privileges you have three options:

1. Install the program to an area of the hard disc where you know you have read,
write and execute privileges.

2. Install the self-extracting version (Method 2 above) to an area of the hard disc where
you know there are no requirements for administrator privileges (the desktop is a
good location). This should avoid most security issues.

3. Try running the installation file or Forest GALES2.5 as an administrator. Right mouse
click on the executable file and choose Run as administrator from the menu (Figure 3).

Figure 3 Run as administrator.

ForestGALES_2.5 » Bin v & Search B 0

»

1 MName Nate maodified

[ copyright.bet 26/02/2014 13:22

| FRRORIOG HQ/DR/015 1204

€, ForestGALFS Opes) E N4

B8 inchy st % Run as administrator i S
rtl.rtf 16:10

Bl repo Troublechanot compatibility !—

B reportd.itf B e p7is1



Help files

By default Forest GALES accesses all help information from the file forestgales25_help_manual.
chm. This is a compiled html file and should work in all versions of Windows®.

If you are having problems with forestgales25_help_manual.chm an optional alternative
version of the help information is provided as the file forestgales25_help_manual.hlp, which
is the classic type of Windows® help file. This can be set as the default help file in Forest GALES
under the Help drop-down menu in the Main form (Figure 4). This file should work:

For versions of Windows® earlier than Windows® 7.

For Windows® 7 (and Windows® 8 under most circumstances) after downloading and
installing the Windows® Help program (WinHIp32.exe) from http://www.microsoft.com/
en-us/download/details.aspx?id=91.

Figure 4 Default file selection.

File Mode DAMS Options Window

.-Lx

T -
| Diefault Help File: (3 forestgales23_help_manualhip

I | 8] forestgales2s help_ manuslchm I

Hecip
About

CtrleH
Crl= A

Uninstalling Forest GALES

To uninstall the program:

1. Press Start, or click the PC settings button in Windows® 8.

Choose Control panel.

Choose Programs: Uninstall a program (or put Control Panel\Programs\Programs and
Features into Windows® Explorer).

Select ForestGALES2.5 from the list of programs (Figure 5).

5. Left click on Uninstall in the banner above the list of programs.

Figure 5 Uninstall.

—~

®© - ¢ b Contrel Panel + Programe b Programs and Tentures v & GenrchProgeams and Fentures 0

Contrul Panel Home

Uninstall or change a program

View instelled updates

Tor unsinstall o preageam, select it T e it ansed ten Bk Uninadall, Changee e Repair,

¥ Tum Windows features on or
oft

Organise *  Uninstall  Change  Repair == oy W
Mamne - Publizher Installed On  Size Version
G Canon Utilities Solution Menu M/T12013
ﬂlndNDte e Thomson Researchboft 2o/ 2N 3 NIME 120032
-;anl Wiehl 1.0 Farestry Commissinn Research . D2/04/201% 3IT6ME 1064
[ 18/ ForestGALES 2.5 Forest Recearch 26/08/2015 JBTMB 255 |
& Google Chrome Google Inc. 31/03/2015 44.0.2403.157

Furest Research Product version:  2.5.5
Help link:  httpy/fwww, forectry.g...

Support fink:  hivps/Swesw forestry g vk frINFD- 635452
Sizet 287 MB

This will remove all the components and data files of Forest GALES2.5 with the exception
of files created while using the program. Exceptions include saved/exported data files and
new yield models. These may have to be manually deleted. The DAMS folder can be deleted

manually.

INSTALLING ForestGALES
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Running the model for the first time

Start the program from the Windows® Start button. After the initial welcome screen you will be
presented with the main menu window as shown in Figure 6.

Choose Mode, Single stand, Prediction using field measurements and a new query form will
appear as shown in Figure 7. The initial default values are as follows:

* Species to ‘Sitka spruce’

* Soil group to ‘Gleyed mineral soils - B’
* Rooting to ‘Shallow (<80 cm)’

* Current spacing to 2.8 m

* Top heightto 20 m

* DBH to 20 cm

* DAMS score of 15

Press the Run button and the Return period, Wind damage risk status and Critical wind speeds
for overturning and breakage will appear in the previously empty boxes at the bottom of the
form. Return periods will be 200 years for both overturning and breakage. Change the top
height to 22 m using the up arrow next to the top height edit box and press the Run button
again. The return periods will change to 13 years for breakage and 133 years for overturning.
You are running Forest GALES!

The various options available for the model are explained in later sections of this manual.

Figure 6 ForestGALES main menu.

Figure 7 Query form for Single stand predictions using field measurements.
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How the model works

The model uses data relating to individual trees to estimate the risk of damage to stands of
trees by answering three questions:

1. What force would be needed to uproot or break the tree?

2. What wind speed would create the force required to damage the tree
(i.e. what is the threshold or critical wind speed)?

3. What is the probability of the threshold wind speed being exceeded?

What force would be needed to uproot or break
the tree?

Trees fail in high winds either by stem breakage, or by overturning as tree are uprooted,
depending largely on how well anchored they are. Forest GALES calculates both the resistance
of the stem to breakage and the resistance of the tree to uprooting.

Resistance to breakage is calculated based on theoretical work on stem strength that regards
tree stems as structures, combined with data on the wood strength and stiffness of different
tree species.

Resistance to uprooting is calculated based on an extensive database of tree-pulling
experiments that relate tree characteristics to the force required to pull a tree over. These
experiments were conducted on a range of soil and cultivation types for many species. The
influence of cultivation and drainage is represented within Forest GALES by rooting depth.
However, for some combinations of species, soil type and rooting depth, data are not available,
and in these cases assumptions are made to allow data to be extrapolated. When this happens,
a warning message box will appear.

What wind speed would create the force required
to damage the tree?

In Forest GALES the wind loading on trees is calculated from the drag the forest exerts on the
flow above the canopy. The drag is a function of the wind speed and the aerodynamic
roughness of the canopy which is dependent on the crown size and the area of ground
occupied by each tree.

Crown size is modelled using regressions based on the height and diameter of the tree.

From a knowledge of the average wind loading on each tree and the resistance to breakage
and overturning, the wind speed that would just cause the tree to overturn or break is
calculated. This includes calculating the extra force due to the overhanging weight of the crown
and stem as the tree bends.

What is the probability of a damaging wind
speed occurring?

Having calculated the wind speed required to damage the tree, the probability of such a wind
speed is estimated.

HOW THE MODEL WORKS
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The average windiness of the site is measured using the DAMS system, which is based on
location, elevation and exposure. However, average winds are unlikely to damage the tree, and
the risk of extreme winds that are sufficiently strong to cause damage must be derived from
DAMS using a Weibull distribution.

This distribution is extremely sensitive, and small changes in the wind speed required to cause
damage can be associated with large changes in the probability of damage occurring.

Having calculated the probability of damage, this is converted to a return period for a
damaging wind speed occurring. This is the average interval between storms that are associated
with damaging winds.

Wind damage risk status provides a rough estimate of risk, ranging from Status 1 (return period
for damaging winds more than 100 years) to Status 6 (return period less than 10 years).



Using Forest GALES

There are several ways to start the program.

The easiest is to press Start, followed by Programs, ForestGALES 2.5, ForestGALES. When this
is done, the program will start and the main menu (Figure 6) will load onto the screen.

Forest GALES has been designed as a complete Windows® application. Menus are easily
accessible with the mouse in the top part of the main window, or they can be accessed using
pop-up windows, shortcut keys or speed buttons.

Operating modes

Forest GALES can be used interactively in two operating modes:

e Single stand mode - calculates the risk for one particular stand.
e Batch mode - calculates the risk for a number of stands one after another.

There are three ways of making predictions within these modes:

e Predictions using field measurements - calculates the risk of damage at a single point
in time from stand characteristics defined by the user.

e Predictions using yield models - calculates the risk of damage at a single point in time
from stand characteristics contained in yield models.

e Predictions through time - calculates the risk of damage over a typical rotation from
stand characteristics contained in yield models.

Selecting a mode and opening a query form

Having started the program, to select a particular mode, left click on Mode at the top of the
main menu.

A menu will appear. Left click on the mode that you want, and the menu will disappear, and
a form will appear automatically.

Alternatively, a new form can be created using the shortcut buttons at the top of the main
window. The meaning of each shortcut button is indicated by a hint message that appears
when the mouse is positioned over the button.

It is possible to have several copies of a query form open at the same time. This may be useful
if you wish to compare alternative scenarios.

Forest GALES query forms

Forest GALES collects data from and writes results to query forms. The exact layout of the form
depends on the mode (single stand or batch) in which the model is being used and the type of
prediction being made (using field measurements, using yield models, through time). Figure 8
shows the layout of the form for Single stand predictions using field measurements.

USING Forest GALES



Figure 8 Query form for Single stand predictions using field measurements.
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Stand characteristics box
Describes the soil, rooting depth, spacing and (where appropriate) planting year.

Tree characteristics box
Describes the size of the trees within the stand being modelled.

Upwind edge effect box
States whether a new brown edge is present, and, if so, the size of the gap created.

DAMS box

Describes how windy the site is. DAMS can be entered directly, calculated exactly, extracted
from a pre-calculated data file for a particular location or estimated roughly. The layout of
the box depends on which selection is chosen.

To locate the DAMS dataset (required for pre-calculated DAMS values) select DAMS (Alt + D)
from the main menu and locate the directory ‘Windscores'. Make sure that the ‘Windscores’
directory is actually open, as shown in Figure 9, by double-clicking on it. Otherwise you will
get the message ‘DAMS data not found in selected directory’.

Figure 9 "Windscores' directory.
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Controls box
Allows the user to run the model, save inputs, load a saved file, print results, close the form,
save defaults and obtain help.

Wind damage risk box
Indicates the risk of uprooting or stem breakage occurring, and the estimated return period.

The query forms for other modes are described in later sections of this manual.
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Navigating Forest GALES
Using the mouse

As the mouse is moved over the query form, any of the components can be selected by
clicking the left mouse button. If text boxes (such as Stand ID), up/down boxes (such as
spacing) or menu boxes (such as species) are selected, then changes can be made to the box
by either typing in text (for the text and up/down boxes) or by selecting the arrow buttons at
the right edge of the box (for menus and up/down boxes).

When one of these boxes is selected then pressing F1 will result in Help being displayed to
describe the use of the box.

If the mouse is moved over one of the buttons then the appearance of the button will change.

Clicking the left hand mouse button will cause the button on the form to be pressed. This can
be used to run the model, print the form, etc.

Using the Tab key

Pressing Tab causes the focus’ to move through each of the controls in turn.

The appearance of focus depends on the type of control. For text boxes, up/down boxes and
menus the focus is indicated by the background becoming blue. For the buttons, focus is
indicated by a thin black border and a black dashed box around the caption (and picture,

if present) on the button.

When a control has focus, pressing F1 will result in help being displayed that relates to the control.

A control which has focus can also be edited, changed or activated as follows:

Text boxes Edit using the keyboard (e.g. Stand ID)
Up/down boxes Edit using the keyboard (e.g. spacing)
Menu boxes Edit using the up and down keys (e.g. species)

Radio buttons  Select using the up and down keys (e.g. windfirm/brown edge)
Buttons Use the Enter key to press the button (e.g. Calculate DAMS or RUN)

Using shortcuts
Shortcuts allow a combination of the ALT key plus a letter to be used to select an option.

The Alt + key shortcuts in the main menu are:
Alt+F  Open File menu

Alt + M Open Mode menu

Alt+A Open DAMS menu

Alt+1  Open Options menu

Alt + W Open Window menu

Alt+H Open Help menu

Within Forest GALES, the shortcut for a particular button is indicated by an underlined letter
in the button caption.

USING Forest GALES



Getting help

Help can be obtained either by clicking on a Help button, selecting Help from the main menu,
or by pressing F1.

Pressing Help starts the help system - this allows the user to search for a particular topic or keyword.

Pressing F1 will display help relating to the component that has focus (usually the last item
where you clicked the mouse). These help pages are therefore ‘context sensitive’.

14 ForestGALES 2.5



Predictions using field measurements

This is the standard type of prediction. It allows the user to calculate the risk of damage based
on the stand’s mensurational characteristics at a single point in time. An example of this type
of prediction is shown on page 33 (Example 1).

The user enters data that describe the site, the tree crop and whether or not a new edge
is present.

In individual stand predictions, pressing Run will then calculate the probabilities of damage
occurring based on the selected options. Making predictions for multiple stands is explained
on page 30 in the Batch mode section.

Stand characteristics box

The Stand characteristics box (Figure 10) allows you to describe the stand for which you wish
to calculate the risk of damage.

Figure 10 Stand characteristics box.

Stand Characteriztics
Stand 1D |FarestGaLES

Soil Group |E: Gleved mineral soilz j
Roating |'I: Shallow Rooting [< 80 cm) ﬂ

Soil and Rooting Help

F

i Current Spacing [m) 28 =
" Current Stacking (M /ha)

Stand ID

An identification for the stand. Note: names longer than 25 characters will not print correctly
if a report is produced.

Soil group

The Soil group option allows you to select whether the main soil type in the stand is a freely-
draining mineral soil, a gleyed mineral soil, a peaty mineral soil or a peat. These four soil
groups appear in the Soil group drop-down menu.

Table 1 shows which individual soil types fall within each group. All soils within each group are
treated as having the same characteristics. For example, if you are not sure whether your soil is
ironpan (freely-draining) or brown earth (freely draining), it does not matter; both will give the
same result.

PREDICTIONS USING FIELD MEASUREMENTS



16

ForestGALES 2.5

Table 1 Soil groups available within Forest GALES, indicating the soil types within each group.

A Freely-draining B Gleyed mineral C Peaty mineral soils | D Deep peats
mineral soils soils

Brown earth Ironpan (gleyed) Ironpan (peaty) Juncus (or basin) bogs
(freely-draining)

Podzol (gleyed) Podzol (peaty) Molinia (or flushed
Ironpan blanket) bogs
S fef Brown earth (gleyed)  Peaty gley
(freely-draining) Sphagnum (or flat

Surface-water gley

Podzol or raised) bogs
(freely-draining) Ground-water gley Unflushed blanket bog
Calcareous soil Eroded bog

Rankers and

skeletal soils

Littoral soils

Man-made soils

Rooting

This describes the depth of rootable soil in the stand. The options are: 1 Shallow <80 cm and
2 Deep 280 cm.

Soil and rooting help

If you need help deciding which soil group or rooting depth to choose for your site click Soil and
rooting help in the Stand characteristics box. This will give a default rooting depth for each site.
Alternatively, use the Soil and rooting help (see Box T on page 18).

Current spacing

The average spacing between trees at the time of risk assessment. It must be between 0.6 and
10 metres.

Current stocking

The number of trees per hectare at the time of risk assessment. The user has the choice
between this option and the previous one.



Tree characteristics box

The characteristics of the average tree of the stand are entered in the Tree characteristics
box (Figure 12).

Figure 12 Tree characteristics box.

Tree Characternistics
Speciez | Sitka Spruce j

| Top height of stand [m] (200 5
tean DBH [cm) 200 %

The options that can be selected from the Tree characteristics box are:

Species
The main species in the stand. Options are:

* Scots pine

* Douglas fir

» Corsican pine

* Noble fir

* Lodgepole pine
* Grand fir

* European larch
* Sitka spruce

* Japanese larch
* Norway spruce
* Hybrid larch

* Western hemlock

Top height
Top height (in metres) of the stand being assessed. This must be between 5 and 75 m.

Diameter at breast height (dbh)

Mean diameter (in cm) of the stand being assessed. This must be between 5 and 50 cm.
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Box 1 Soil and rooting help

Soil and rooting depth help is available in Forest GALES either by clicking on Soil and
rooting help in the Stand characteristics box, or by using the table shown opposite.
These can be used to identify which soil group and rooting depth to allocate to your site.

The numbered soil types listed in the table correspond to the Forestry Commission soil
type classification set out in the Forestry Commission Field Guide The identification of
soils for forest management. Choose the numbered soil type in the table that best
matches your site soil type. Referring to the soil characteristics at the top answer the
questions (yes or no) that apply, to determine which soil group and default rooting depth
to use in Forest GALES. Cells shaded grey can be ignored. Note that some of the
numbered soil types match a soil group and default rooting depth with no questions.

The 'Rooting depth’ that is indicated by the helper is a default rooting depth that you can
use if you have no information about rooting in the stand. However, if the rootable depth
is known to be limited to <80 cm on a site, a default deep rooting should be adjusted to
shallow as appropriate. Similarly, if rooting depth is known to be >80 cm, a default
shallow rooting should be adjusted to deep.

In Single stand mode, the Soil group and rooting depth are selected using the drop-
down menus in the Stand characteristics box. If you are using Batch mode, enter the
appropriate codes in your input file (see page 19).

Soil and rooting help box.

< Soil and Rooting Helper =0 x|
e en

Select a soil from one of the 4 soil groups (A, B. C or D). Ref: Kennedy [2002] and FG User Guide
Tor some zoils [Drown sasths, fronpans, Modzols and Nankers] please also check whether the sof is gleped or peaty.

—#: Freely-draining mineral sollz:——— —B: Gleyed mineral solle [ C:Peatyminsal eoile——————— D:Desppeate
s i r ;
Brown easth [fieek-draining] Brown earth [gleyed)  lisc iyl  Juncus {or basinl bogs
" Ironpan [freedy-craining) " Ironpan [gleyed)
i  Molinia (of flushed blanket) bogs
" Podzol [frecly-draining) I Todzol [gleyed) C Podzal (pesty]
" Calearsous zol (frash-draining]  Caloasous sl [gayad] © Sphagrum (o flat o rived) bags
7~ Rarkers and skeletal {brosen)  Rankers and skeletals [geyped) | | { Rankers and Skeletal: (peaty)
e ) e " Unilushed blanket bog
" Littoral sails (" Surface-water gley =
Peaty ole
" Manmade snis ( Groundwater gy s ® )

Soil Rooti nd Click Okay to accept
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Forestry Soil characteristics Entry for Stand characteristics box

Co”n:mission Indurated/ | Iron pan | Peaty | Gleyed | Brown Soil group Rooting
SOLBY RS plough pan/ | broken depth
hard pan

v Freely-draining mineral soils Shallow Al
X X Freely-draining mineral soils Deep A2
X 4 Gleyed mineral soils Shallow 1
—--
v Freely-draining mineral soils Shallow Al
X v 4 Peaty mineral soils Shallow Cc1
X v X Peaty mineral soils Deep C 2
X X v Gleyed mineral soils Shallow B 1
X X X Freely-draining mineral soils Deep A2
v v v Peaty mineral soils Shallow c1
v 4 X Peaty mineral soils Deep C 2
v/ X v Gleyed mineral soils Shallow B 1
v X X Freely-draining mineral soils Deep A2
X v Peaty mineral soils Shallow c1
X X v Gleyed mineral soils Shallow B 1
X X X Freely-draining mineral soils Shallow Al

v Freely-draining mineral soils Shallow Al
X Gleyed mineral soils Shallow B 1
v Peaty mineral soils Shallow C1
X v Gleyed mineral soils Shallow B 1
X X Freely-draining mineral soils Shallow Al

PREDICTIONS USING FIELD MEASUREMENTS
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DAMS box

DAMS is a measure of site windiness. The greater the value, the windier the site. Only values
between 5 and 32 (the range of values found in Britain) will be accepted by the model. If the
DAMS score for the site is known then it can be entered directly. If it is not known then it can
be estimated, looked up or calculated by the program. The DAMS box is displayed in Figure 13.
The effect of changing the DAMS value is shown in Example 4 (page 36).

Figure 13 DAMS box.
DAMS

f* Gnd Reference © Caloulation

MH180150  Apply. | DAMS Scae|15 %

Rough guess method

In the DAMS box, select Calculation then click the Apply... button. The calculation box will
appear. Selecting the Rough guess box (Figure 14) will give the opportunity to estimate the
DAMS score. Select the options that best describe the site based on region within GB,
elevation, shelter and aspect. Press Apply to copy the resulting DAMS score to the query form,
or Cancel to close the window without copying the value across. This method is particularly
useful for making general comparisons between sites. An example of this method of obtaining
DAMS is shown on page 37 (Example 5).

Figure 14 Rough guess box.

DAMS Calculation
3: Exact Calculation |
FRoault
B Region [VWest & North Coast Scotland & Isiands v | || DAMS 23
Elevation [Top of Hill =] | Econon
Sherer |We|| Sheltered ﬂ [® 2poly
Aspect Al =
| _J & Help
XK Carcel

Grid reference method

In the DAMS box, the user can select Grid reference and then enter the grid reference of
the site; the DAMS score, if available, will be displayed. Example 6 (page 37) shows the use of
the grid reference method for obtaining DAMS.

Exact calculation method

In the DAMS box, select Calculation then click the Apply... button. The calculation box will
appear. Selecting the Exact calculation box (Figure 15) will give the opportunity to calculate
the exact DAMS score. The Wind zone for the location can be found using the map that is
displayed when View map is pressed. DAMS scores and wind zone boundaries are discussed in
Forestry Commission Research Information Note 230 Revised windiness scores for the windthrow
hazard classification. Elevation is entered together with the Topex values for each of eight
compass directions (TOPEX is the angle to the horizon in whole degrees in the particular
compass direction, with values less than zero being entered as zero). The resulting DAMS score
can be copied to the main form by pressing Apply, or discarded by pressing Cancel. Example 7
(page 38) illustrates use of exact calculation for obtaining DAMS.



Figure 15 Exact calculation box.

DAMS Calculation
Rough Guess | l e
Wind Zone M 2 WiewMap. DAMS ’23—
Elevation (m) 200 3} Contiols
Topesr 1] Apply
North 0 % Souh 0o =
NothEast [0 %] Southwest [0 2 & Help
East 0 #  west =
SoutnEast [0 3] menwest |0 B || 3o o

Upwind edge effect box

The Upwind edge effect box (Figure 16) is used to describe whether a new non-wind-firm
edge has been created adjacent to the stand being modelled. Brown edges (i.e. edges that
were originally not at the stand edge) are often a place where wind damage starts. If a new
edge has been created then the Brown edge button should be pressed. The size of the gap
can then be altered. The default value is 0 m. The effect of a gap increases with gap width
until the size equals 10 x mean tree height, after which the effect remains at a maximum.
An example of changes to the upwind edge is shown on page 34 (Example 2).

Figure 16 Upwind edge effect box.

Upwind Edge Effect
o windfirm edge

(" Brown edge - Size of gap (m] |7 ¥

Controls box

The Controls box (Figure 17) allows the user to control Forest GALES. The options are
described below.

Figure 17 Controls box.

—— Runs the model using the selected values. Shortcut is Alt + R.
< Prints the current query form. Shortcut is Alt + P.

Creates a report that contains all the information on the form.
| Thereport can be printed or saved for later use. Shortcut is Alt + T.

I Starts the Help system. Shortcut is Alt + H.
= Open File <— Opens a previously saved query form. Shortcut is Alt + O.
Save File < Savesaquery form, so that it can be reused at a later date. Shortcut is Alt + S.

'[% Default: < Changes the saved default values to the ones included in the query form.
Shortcut is Alt + D.

X Close <« Closes the current query form. Shortcut is Alt + C.

PREDICTIONS USING FIELD MEASUREMENTS
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Wind damage risk box

Model outputs are displayed in this box (Figure 18).

Figure 18 Wind damage risk box.

L e ey e

OVERTURNING [155 | Slhel [27Amis

1 253456
R
BREAKAGE Ex] |'ij--'- — i T WHC |5

Critical wind speed

The critical wind speeds (i.e. the lowest wind speeds that will cause overturning or breakage)
are presented. By default these are presented in m/s. Wind speed units can be changed in the
Options menu.

Return period

The average length in years between wind speeds exceeding the critical wind speed occurring
at the site. This is the average interval between gales that will damage the site. The statistical
nature of the wind climate means that strong winds with long return periods (i.e. > 50 years)
may occur within a few years of each other. The occurrence of a damaging storm does not
alter the risk of further damage in subsequent years.

Wind damage risk status (WDRS)

Wind damage risk status is a measure of the risk of damage either by overturning or stem
breakage. Six classes of WDRS exist. These are colour coded as a visual guide to the user:
1,2 - green; 3,4 - orange; 5,6 - red, as shown in Table 2.

Table 2 Wind damage risk status (WDRS) and associated return periods.

33-20 years
20-10 years
[ o]

Unlike the Windthrow hazard class (WHC) classes, the risk status of a site will change over time.
If the risk status for stem breakage is greater than for overturning, then stem breakage is likely

to be the predominant form of damage, whereas if the risk status is greater for overturning than
for breakage then uprooting is likely to be the predominant form of damage.

Windthrow hazard classification (WHCQ)

The WHC class for the site, based on the 'traditional system described in Forestry Commission
Leaflet 85 Windthrow hazard classification, using the DAMS score and soil type. This is provided
to allow comparisons to be made between the old and new system.



Predictions using yield models

This type of prediction allows the user to calculate the risk of damage at a single point in

time based on stand characteristics defined in yield models. It is particularly useful when the
mensurational characteristics of a stand are not known or when wanting predictions made at
a single point in the future. Figure 19 shows the predictions using yield models query form for
single stands. Making predictions for multiple stands is explained in the Batch mode section.
An example of this type of prediction is shown on page 35 (Example 3).

A selection of yield tables is distributed with Forest GALES, and is stored in the directory
\yldmdls. To select a yield model, choose the species, then select the yield class, thinning
regime and initial stocking that apply. Only the yield models which are available can be
selected from the program. It is, however, possible to create new yield models which can
be used as input for Forest GALES. This is described on pages 25 to 26.

Figure 19 Query form for Single stand predictions using yield models.

&% Single stand predictions using Yield Models =N =R |
Shand Chassstenitics Tres Charscterivics Centiels
SindiD  [FoedGALES Species [Siha Spaien =
Sod G |B: Dibegpeed el sole - & Drirk Form
Resting [T, Shakow Fustrg < B0 cml =

p— ]
Sail and Rooting Help “Voekd Chascs 1 =l
Thinnieg regine.  [Cion Thawig - &t
Inkisd specinaiml [ 1.7 2 || & openFne
I Plorkogsen 150 3] e [s ERR B soeotin

DAMS Uprnd £ g Elfect 15 Delouts
@ Gim Aelmence  Cauldion = b g
HITEOIS0  punh | DAMS Scoe[18 3] || 7 Pawnedoe Sz ofgsoin) [0 2 W Duee
Wird Tamage Bisk

Febari e Wired Diamage Hich Stalus Cifcal vl spmed Crbal verd siend 8t
IVERTUBHING [200 I BT [moms [1egms
12344558
BREAKARE [0 — N TR W67 s wHE [5
webulbA cakusted fom DM,

Stand characteristics box

As for Predictions using field measurements, the Stand characteristics box contains the
Stand ID, Soil group and Rooting options (see page 15). The current stocking cannot be
specified as this is taken from the yield tables.

Planting year
A planting year can be specified. This will automatically adjust the stand age to the present in

the Tree characteristics box. If you want to make a prediction into the future adjust the age of
the stand (see below) instead of specifying a planting year.

PREDICTIONS USING YIELD MODELS
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Tree characteristics box

When predictions are made using yield models, the Tree characteristics box shows the same
Species option as found in the predictions using field measurements (see page 17). However,
the other options are different:

Yield class

The thinning model regimes displayed will depend on the yield models available, as described
in the Forestry Commission software Forest Yield: a PC-based yield model for forest management
in Britain.

Thinning regime

* Intermediate thinning with no delay

* Intermediate thinning with five year delay
* Intermediate thinning with ten year delay
* Line thinning with no delay

* Line thinning with five year delay

* Line thinning with ten year delay

* Crown thinning

* No thinning

Initial spacing

The initial spacing (in metres, based on square planting) should be selected. The range varies
from 0.9-4.5 m depending on yield models available.

Age

The age of the crop to be modelled. The valid range varies between yield models. Ages
between published values are calculated using linear interpolation between the nearest
younger and nearest older published value. By default if the date of planting has been entered
then the age of the stand will be calculated. This will give the risk now. It is possible however
to change the date, allowing the risk to be calculated at some other time.

The Tree details’ button

If this button is pressed then the height, diameter, current spacing and volume of the trees will
be displayed. This is designed to provide information about the type of stand being modelled.

Other boxes

The DAMS box, the Controls box, the Upwind edge effect box and the Wind damage risk
box are identical to those described on pages 20 to 22.



User-defined yield models

New yield models can be constructed for use within Forest GALES using a word processor,
or spreadsheet program.

Currently Forest GALES doesn't contain a user-defined yield model helper. Yield models must
therefore be created using a word processor or Windows® Excel. The general layout of the
yield model file is described below. A Windows® Excel template is included with Forest GALES
in directory yldmodls\userdefined and is called yieldmodel.xls.

The format of the model is illustrated in Table 3 and is:

Line one: a header to describe what is in each field
Line two onwards: fields separated by a single space to define

* Age (years)

* Top height (m)

* Stocking density trees/ha

* DBH (cm)

* Basal area (m*/ha)

* Mean tree volume (m?*/tree)
* Volume per hectare (m?/ha)

In each case data refer to the main crop after thinning. This is the format of the Forestry
Commission yield models.

Table 3 Layout of a yield model for use in Forest GALES.
Age (years) | Top height | Trees/ha | Mean DBH | Basalarea | Mean tree

(m) (cm) (m?/ha) volume
(m?)
20 7.4 2781 il
25 9.2 2300 13 32 0.06 90
30 10.9 1900 15 38 0.10 120

Naming user-defined yield models

The file should be saved as a text file with a file extension of .yld. If Forest GALES is to recognise
the model then it must be named in a specific way. This consists of an 8 character name.

1. The first two characters indicate species; these are shown in Table 4.
2. The second two characters refer to the yield class (02-30).
3. The third two characters refer to thinning regime, and are shown in Table 4.

4. The final two characters refer to initial spacing in metres x 10. Therefore 0.9 m spacing
becomes 09, and 2.1 m spacing becomes 21.

PREDICTIONS USING YIELD MODELS
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Table 4 Species and thinning codes for naming user-defined yield models.

NS
SP
LP
Ccp
EL
JL
HL
DF
GF
NF
WH

Sitka spruce
Norway spruce
Scots pine
Lodgepole pine
Corsican pine
European larch
Japanese larch
Hybrid larch
Douglas fir
Grand fir
Noble fir

Western hemlock

Intermediate thinning no delay
Intermediate thinning five years delay
Intermediate thinning ten years delay
line thinning no delay

line thinning five years delay

line thinning ten years delay

crown thinning

non-thinning

user-defined thinning regime
user-defined thinning regime

user-defined thinning regime

A user-defined model for yield class 18 Sitka spruce for a non-standard thinning regime
planted initially at 2.0 m spacing would therefore be saved as SS18T120.yld.

The file should be saved in the directory yldmdIs\XX\ where XX is the two letter species code
indicated in Table 4.

If a new model is created with an identical name to a model that already exists, then the old
model will be lost.

Using Windows® Excel to create user-defined yield models

1. Open the file yieldmodel.xls in Windows® Excel. It is in the directory \yldmdIs\userdefined\

wherever you have installed Forest GALES.

2. Type data for the yield model into the template.

3. Extra lines can be added as necessary. If the template contains more lines than are needed,

then remember to delete the extra lines.

4. Press File, Save As.

5. Choose the option Formatted Text(Space delimited)(*.prn).

6. The file must be saved in the directory XX, where XX is the two character species code
indicated in Table 4.

7. Type the filename according to the format described on page 25 to 26.

Note: The filename must be enclosed in quotes (e.g. 'SS201Z720.yld"), otherwise the file
extension .prn will be added resulting in a filename called something like S5201220.yld.prn

8. Press Save.

The new model will be accessible within Forest GALES when a new Predictions using yield
models query form is opened.



Predictions through fime

Predictions through time allow the user to calculate the risk of damage to a stand over part or
all of its rotation, rather than at just a single age.

Figure 20 shows the predictions through time query form for single stands. Making predictions
for multiple stands is explained in the section on page 30 (Batch mode section). The main
difference between predictions through time and predictions at a single point in time is that
the results are displayed on a separate form when the model is run. Also, there is no option for
modelling the effect of a new edge.

Figure 20 Query form for Single stand predictions through time.

5 Singhe stand predictions through time ==
Stand Charnctenistics Tiers Chasachrssstics Cannitsol
St [ersGAlES Spees. [Siha Speuce -] 3 Fin

52 Gesary [ Bleyod mineral 2nds =l & Bk Fom
Rocting [ Shalow Roniig [ em] ]
Soil and Nooting Help | fiekd Dz i -
Thining téging | Crowm Thiri v o bev
il spacemg ) [1.7 - = Ooen Fie
[ = FE
vANS S T4 Delmz
& lind Felaence © Caiculabon
FHTRNED  Ageh. | DAMS Seoe]Td 2] X Cate

Stand characteristics box

This is identical to the Stand characteristics box in predictions using yield models (see page 23)
except that year of planting is not available, since predictions through time calculates risk over
the whole rotation, not at just a single age.

Tree characteristics box

This is identical to the Tree characteristics box described on page 24 except that age is not
available.

DAMS box

This is identical to the DAMS box described on page 20.

Controls box

This is identical to the Controls box described on page 21, except that a report cannot be created.

PREDICTIONS THROUGH TIME
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User-defined yield tables

New yield tables can be constructed using the method described on pages 25 to 26.

Viewing the results

Figure 21 shows a typical results form. The form has four areas: a graphics window, two tabular
windows and a Controls box. These are described below.

Figure 21 Results form for Single stand predictions through time.
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The graphics window

The graphics window indicates the return period in years for damaging storms at intervals
throughout the rotation. Typically as the trees grow older and taller the risk of wind damage
increases and the return period therefore decreases.

The graph contains two lines. The red line indicates the risk of overturning, and the blue line
indicates the risk of stem breakage. The data relate to average trees (i.e. with mean diameter
and height) based on the yield tables.

Details of the graph can be investigated as follows:

Zooming into the graph:

* Place the mouse cursor at the top left hand corner of the area you wish to zoom in to.

* Hold down the left mouse button.

* With the mouse button held down, move the mouse to the lower right hand corner of
the area you wish to zoom in to.

* Release the mouse button.

* The display will then change to the selected area.

Note: there is a minimum area which can be selected, and if a smaller area is selected then
no zooming will occur.
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Scrolling around the graph:

* Place the mouse cursor somewhere on the graph.
* Hold down the right mouse button.

* With the right button held down, move the mouse.
* The graph will move as you do this.

Resetting the graph:

* Place the mouse cursor on the graph.

* Hold down the left hand mouse button.

* With the left button held down move the mouse to the left and upwards.
* The display will then revert to the original state.

Note: there is a minimum area which can be selected, and if a smaller area is selected, then the
graph will not reset.

Displaying new results:

The effect of changing the yield model used can be observed directly in the graphics window.
Go to the query form, change any parameter, press the Run button and the graphics display
will change. This allows the user to easily observe the effect of changing the thinning model or
soil type or species, for example.

The tabular data windows

The table window on the left hand side indicates how return period changes with age, and
provides details on height, diameter, spacing and volume of the crop with age. The date when
the crop enters each Wind damage risk status (WDRS) is displayed in the table window on the
right hand side. Data can be exported as described below.

The results form controls box
The controls that can be used on the results form are:

Print Form (Alt +P) Prints the current query form.

Report (Alt +T) Creates a report that contains all the information on the form.
The report can be printed or saved for later use.

Help (Alt + H) Starts the Help system.

Excel® Export (Alt + X) Allows the user to export the tabular results to Windows® Excel.

PREDICTIONS THROUGH TIME
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Batch mode

Forest GALES has been designed to allow batch files of data (i.e. multiple stands) to be
processed, in addition to assessing the risk to stands one at a time. This allows data for a whole
forest, property or coupe to be stored and calculated together.

In this mode, data are read in from one file, and output to a different file. This can be very
helpful if a large number of stands need to be assessed at the same time. Those stands would
not necessarily have to be linked to each other as the calculations are made independently.
The Batch mode can be used with each type of prediction.

The interface of Forest GALES in Batch mode is different from that used for individual stands,
and contains input and output areas as well as the control panel. Figures 22-24 show the
interface for each type of prediction.

Figure 22 Query form for Batch mode predictions using field measurements.
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Figure 23 Query form for Batch mode predictions using yield models.
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Figure 24 Query form for Batch mode predictions through time.
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Creating batch input files

Input files can be created using the Batch mode helper window that appears in front of the
query form when working in the Batch mode (see Figures 22-24). Special codes are needed for
some parameters, so the use of the Batch mode helper application is recommended.

However, the input files can also be created from a spreadsheet. If doing so, it is recommended
to add a line of input to the form using the Batch mode helper, then clicking Save inputs. Open
the resulting file in Excel, and use it to ensure correct formatting. Note that DBH values can be
entered in either cm (1-99 cm) or in metres (0.01-0.99 m). All outputs are written in cm.

When a batch file is opened using Open file on the query form, a progress box appears. When
the file is loaded this is replaced with the message “File successfully opened”. For very large files
(thousands of lines) on occasion this progress box may appear to freeze. Be patient, and the file
will open.

Batch mode helper

The Batch mode helper allows the user to select inputs from menus, and these are then written
to the input area of the query form. This is useful because Forest GALES uses coded values to
describe the species and site rather than descriptions, and these values may be difficult to
remember. For each prediction type, the options are identical* to those described for the
corresponding query form in the Single stand prediction mode (See the sections starting on
pages 15, 23 and 27).

Note: Clicking on Close causes both the helper and the Batch mode query form to be closed.
Unless you want to discard the inputs, click on Calculate risk before closing the helper.

Controls box
The controls in the Batch mode helper are:

Add (Alt + A) Adds the selected values to the input area of the query form.

Print Form (Alt + P) Prints the current query form.

Help (Alt + H) Starts the Help system.

Defaults (Alt + D)  Changes the saved default values saved to the ones included
in the query form.

Close (Alt + C) Closes both the helper and the query form.

Batch mode query form

The characteristics of the stand are entered in the input area. All data relating to a single stand
are displayed on the same line. After running the program, the results of the model are
displayed in the output area. If the data have been saved then the filename will be displayed
at the top of the output area. The outputs vary slightly depending on the mode you are
running in (see Table 5).

* There is a slight difference when making predictions for Batch mode using yield models. The year
at which you wish to calculate the risk has to be specified on the query form rather than in the helper.

BATCH MODE
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Table 5 Modes available for multiple stand predictions.

e Joupue

Predictions using field Return period for overturning, wind damage risk status for
measurements overturning, return period for breakage, wind damage risk
status for breakage.

Predictions using yield models ~ Model used, current top height (m), current DBH (m), current
spacing (m), return period for overturning, wind damage
risk status for overturning, return period for breakage, wind
damage risk status for breakage.

Predictions through time* Model used, age to reach WDRS 1 to 6 for overturning,
age to reach WDRS 1 to 6 for breakage.

* Double clicking on any of the input lines in this mode will open the graphics display window as for a
single stand. In this way it is possible to observe differences between the risk for all the stands entered as
inputs.

Controls box
The controls in the Batch mode query form are:

Calculate Risks (Alt + R) Runs the model using the selected values.

Delete Row (Alt + E) Deletes a row of data from the input area.

Open File (Alt + O) Opens a previously saved query form.

Save Inputs (Alt + N)  Saves the input file for later use.

Save Outputs (Alt + U)  Save the output file so that it can be exported to another application.
Help (Alt + H) Starts the Help system.

Excel® Export (Alt + X)  Allows the user to export the tabular results to Excel®.

Year of calculation

When you are in the Predictions using yield models mode then the option is provided to
modify the Year of calculation in the bottom right corner. The default is the current year but
any year in the past or future (up to 2100) can be chosen. If the age is less than the minimum
in the yield table the model defaults to the minimum age. If the age is beyond the maximum
age in the yield tables the model defaults to the maximum age.



Examples

1: Single stand predictions using field measurements
- getting started
1. Start Forest GALES.
2. Left click on Mode
=> The Mode dialog box will open.
3. Choose Single stand, Predictions using field measurements

=> A new query form will open. This form has a range of pre-selected options. However, no
value will be present in the Wind damage risk box.

For the purpose of this exercise, make sure the default options are set to the following values:
Species Sitka spruce, Soil group Gleyed mineral soil - B, Rooting Shallow (<80 cm), Spacing
2.8 m, Top height of stand 20 m, Mean DBH 20 cm, DAMS Score 15, Windfirm edge.

4. Left click on Run

=> Values of 200 years will appear in the Wind damage risk box for the Return period for
both overturning and breakage.

5. Left click on the up button to the right of the Mean DBH box
=> The DBH will increase by 0.1 cm per ‘click’.
6. Keep changing the DBH in this way until a value of 22 cm appears in the box.
7. Change Top height until it reads 22 m.
8. Change Current spacing until it reads 3.5 m.
9. Left click on Run

=> The values in the Wind damage risk boxes will change to 30 years for Return period for
overturning and 8 years for Return period for breakage.

This indicates that the risk of damage changes rapidly with changes in DBH, height and
spacing. Other parameters can be changed in a similar way.

EXAMPLES
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2. Single stand predictions using field measurements
- the effect of a new edge

This example shows how creating new edges affects the risk of damage.

1. Start Forest GALES and open a query form for Single stands predictions using field
measurements in the same way as the previous example. Set the options to: Species Sitka
spruce, Soil group Gleyed mineral soil - B, Rooting Shallow (<80 cm), Spacing 2.8 m, Top
height of stand 20 m, Mean DBH 20 cm, DAMS Score 15, Windfirm edge.

2. Left click on Run

=> This will give the return periods for damage for the default parameters, and no new edge.

3. Left click on the Brown edge button

=> A black dot will appear on the button, and the value for size of upwind gap will become
black. Change the Size of gap to 400 m.

Using the pre-selected values left click on Run

=> The values in the Probabilities boxes will change and should become 8 years for
Return period for overturning and 3 years for Return period for breakage.

This indicates that the risk of damage is much greater if a new edge is present, than if no
new edge is present. The Gap size box will also have changed to 188 m. This is 10 x the
mean tree height. Gap widths greater than this have no additional effect on stability.

4. Now try changing the size of the gap to 20 m and left click on Run

=> The values in the Probabilities boxes will change and should become 16 years for
Return period for overturning and 5 years for Return period for breakage.

Again, try changing other options to see what happens.



3: Single stand predictions using yield models
This example shows how to use yield models to provide input data for the model.
1. Left click on Mode

=> The Mode dialog box will open
2. Choose Single stand, Predictions using yield models

=> A new query form will open. This form has a range of pre-selected options. However, no
value will be present in the Wind damage risk box.

For the purpose of this exercise, make sure the default options are set to the following
values: Species Sitka spruce, Soil group Gleyed mineral soil - B, Rooting Shallow (< 80 cm),
Yield class 14, Thinning regime Crown thinning, Initial spacing 1.7 m, Age 44
DAMS Score 15. Windfirm edge.

3. Left click on Run
=> This will give the probabilities of damage for a stand of YC 14 Sitka spruce, planted at 1.7
m spacing with a crown thinning regime at an age of 44. The values in the Probabilities
boxes will change and should become 200 years for Return period for overturning and 200
years for Return period for breakage.
The size and spacing of the modelled trees can be viewed using the Tree details button.

4. Now change the age to 50 and left click on Run

=> The values in the Probabilities boxes will change and should become 96 years for Return
period for overturning and 83 years for Return period for breakage.

This indicates that the risk is increasing with stand age.
5. Now left click on the down arrow to the right of Thinning regime

=> A menu of thinning options will appear as you move the mouse over the options, they
are highlighted in turn.

6. Left click on Intermediate with no delay
7. Left click on Run

=> The values in the Probabilities boxes will change and should become 200 years for the
Return period for overturning and 200 years for the Return period for breakage.

Again, try changing other options to see what happens.
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4: DAMS

This example demonstrates the use of DAMS as an input for the model.

1. Start Forest GALES and open a query form for Single stand predictions using yield models in
the same way as the previous example.

2. Set the options to: Species Sitka spruce, Soil group Gleyed mineral soil - B, Rooting Shallow
(<80 cm), Yield classs 14, Thinning regime Crown thinning, Initial spacing 1.7 m Age 44,
DAMS Score 15, Windfirm edge. Left click on Run

=> This will give the probabilities of damage for a typical tree in a stand of YC 14 Sitka
spruce, planted at 1.7 m spacing with a crown thinning regime at an age of 44. The values in
the Probabilities boxes will change and should become 200 years for Return period for

overturning and 200 years for Return period for breakage.

3. Within the DAMS box, use the up and down arrows to select 17 as the value of DAMS score.
The higher the DAMS score the windier the site.

4. Leave the options as they are and left click on Run

=> The return periods should change to 30 years for the Return period for overturning and
28 years for Return period for breakage.

It should be apparent that relatively small changes in DAMS result in large changes in
calculated risk.

Again, try changing other options to see what happens.



5: DAMS - rough guess

This example demonstrates using a rough estimate of DAMS as an input for the model.
1. Start Forest GALES and open a query form for Single stands predictions using yield models.
2. Within the DAMS box select the Calculation button then click Apply...
=> A new form will appear.
3. Left click on the Rough guess tab
=> New options will appear.

4. Select GB Region Scottish & English Borders, Elevation Mid-Slope, Shelter Exposed,
Aspect West.

=> 18 will appear in the DAMS box. Pressing Apply would copy this value to the query form.
5. In the GB Region box, select central Wales
=> 17 will appear in the DAMS box.

Again, try changing other options to see what happens.

6: DAMS - grid reference

This example demonstrates how to obtain the DAMS score for a specific grid reference.

1. Start Forest GALES and open a query form for Single stands predictions using yield models.

2. Within the DAMS box click the Grid Reference button. Press Apply...
=>15 will appear in the DAMS box. This is the value of DAMS for NH180150. If Forest GALES
cannot find the DAMS data it will ask you to locate it. The Find files option in the Windows
start-up menu may be useful for this.

3. Type NY659932 in the Grid reference box

4. Left click Apply

=>17 will appear in the DAMS box.

Again, try changing other options to see what happens.

EXAMPLES
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7: DAMS - calculate DAMS score

This example demonstrates how to obtain the DAMS score for a location based on ground
measurements.

1. Start Forest GALES and open a query form for Single stands predictions using yield models

2. Within the DAMS box select the Calculation button then left click Apply...
=> A new form will appear.

3. Left click on the Exact calculation tab
=> New options will appear. By default, 23 will appear in the DAMS box. This would relate to
a hill top site at 200 m elevation in the west of Scotland. Pressing Apply would copy this
value to the query form.

4. To change the location left click on View map
=> This will cause a new window to appear.

5. Left click in the dark blue area in central Scotland (north west of the Tay estuary).

6. Press OK

=> The wind zone value 3 should be placed into the Wind zone box and 15 will appear in
the DAMS box.

7. Select 100 in the Elevation box
=> 13 will appear in the DAMS box.

8. Enter Topex scores as shown in Table 6.

Table 6 Example Topex values.
North 0 South
North-east 3 South-west
5 West

South-east 10 North-west

=> 10 will appear in the DAMS box.

Again, try changing other options to see what happens.
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Research mode

To access Research mode click Options and then click Research mode (or click Ctrl + R)
(see Figure 25).

Figure 25 Research mode.

e

File Mode DAMS | Options | Window Help

e | Select Wind Speed Units v
‘ _ﬂ; Research Mode Ctrl+R

Research mode allows users greater flexibility in some aspects of using Forest GALES.

Specifically:
* A wide range of parameters have been extracted into external parameter files, both general
to the whole model and species-specific.

* There is a facility to add user-defined species, yield models and rooting depth/anchorage
coefficient.

* There is a facility to set Weibull_A directly in the parameter file (rather than calculate it from
DAMS). This can be used in the single stand modes, and in the standard batch modes if the
same Weibull_A and Weibull_K are to be applied to all stands being analysed.

* An additional batch mode has been included, using field measurements, where Weibull_A
and Weibull_K are entered on the input form instead of DAMS. This enables the Weibull
parameters to be varied for each stand being analysed. This mode is shown using an
additional icon to the right of the six standard modes at the top of the Forest GALES main
window. This mode also allows very long files (longer than 32994 lines) to be processed.

* A detailed range of outputs are now optionally saved to file.

Click Help | Help to access help files for Research mode. There is also a Technical appendix
detailing the equations used within Forest GALES.

Changing parameters

In earlier versions of Forest GALES, parameters were hard to change because they were
embedded in the code. Forest GALES 2.5 has external parameter files, enabling users to easily
alter parameters. One file contains universal constants, physical and aerodynamic parameters.
A separate set of files, one for each species, contain parameters and variables that differ
according to species.

These files can be edited using any text editor. However, it is easiest to use a text editor that

enables Forest GALES to access the file while it is open within the editor, so the file need not be
closed each time the program is run.

RESEARCH MODE
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These files are read each time Forest GALES is run (i.e. 'Run’ or 'Calculate risks' button pressed).
This means that they can be altered, saved, and the model rerun without needing to close
Forest GALES between runs.

The name, file location (with respect to the executable Forest GALES file) and file formatting are
hardwired into Forest GALES 2.5. If a parameter file is not found, or is formatted incorrectly, an
error message will appear and the program will do no calculations. In Batch mode, no
calculations will be done for the affected input row and all subsequent rows. The program does
not need to be closed while the problem is resolved. For example, if the message 'File
FGParameters.txt not found' appears after clicking Run, click OK, then ensure that the file is in
the correct location, and click Run again.

The format of the two types of parameter files are shown within this document. In addition,
Read-only versions of example files are provided: ExampleFGParameters.txt and
ExampleSpeciesParameters.txt.

A Restore defaults option is available, which will return all values in all external parameters files
to the installation values.

Click Options | Restore defaults or Ctrl + shift + Z

Constants and limits input file

The file containing constants and model limits is called FGParameters.txt. It is held in the root
directory of Forest GALES 2.5 (i.e. ForestGALES 2.5\FGParameters.txt) and must not be moved
from here.

The parameters held in this parameter file are:
Physical ‘constants'

* Snow density (kg/m?)

* Von Karman constant

* Air density (kg/m?)

* Acceleration due to gravity (m/s?)

Model limits

* Number of tree heights from edge assumed to be in forest

* Size of gap regarded as infinite (in tree heights)

* Limit defining resolution of Forest GALES model

* Multiplier defining number of sections in each metre length of trunk e.g. multiplier =
2 to have 0.5 m sections; multiplier = 0.5 to have 2 m sections (more sections means more
accuracy but slower computation time)



Aerodynamic parameters

* Element drag coefficient (CR): used to calculate zero plane displacement '

* Surface drag coefficient (CS): used to calculate zero plane displacement '

* Constant (CW): used to calculate Roughness 2

* Height above zero plane displacement at which we require wind speed (m)

* Roughness of land surrounding forest (m) [not used in this version of Forest GALES]

* Ua: used in calculation of annual exceedance probability

* Four parameters used in calculation of Uc: used in calculation of annual exceedance
probability 4

* Weibull_K*

* Code for Weibull_A calculation method [1: Entered directly; or 2: Calculated from DAMS]

» Weibull_A [used if code is 1]°

* Two parameters for calculating Weibull_A from DAMS [used if code is 2]°

Refer to the Technical appendix to see how these values are used:

'See Equation 10
?See Equation 11
See Equation 18
“See Equation 19
>See Equation 20
®See Equation 17 [These Weibull parameters are not used in Batch-Weibull mode]

The structure of the FGParameters.txt file is shown below. Lines with comments and parameter
names begin with #. Parameter values are on the line below the parameter name.

RESEARCH MODE
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FGParameters.txt

# FG2.5Res

# File containing constants, model limits and aerodynamic parameters
#

# Each comment describes the line below

#

# SNOWDENSITY: snow density kg/m?

150

# K: von Karman constant;

9 04

10. # RO: air density kg/m?

11.1.2226

12.# G: acceleration due to gravity m/s?

13.9.87

14.# TREE_HEIGHTS_FROM_EDGE: number of tree heights from edge assumed to be in forest
15.9

16. # BIGGAP: size of gap regarded as infinite

17.10

18. # LIMIT: defines resolution of Forest GALES model
19.0.07

20. # CR: Element drag coefficient

21.03

22.# CS: Surface drag coefficient

23.0.003

24 # CW: Constant

25.2

26.# CALC_HT: height above zpd at which we require wind speed
27.10

28.# FIELD_ZO: Roughness of land surrounding forest
29.0.06

30.# Ua:

31.5

32.# U_CT: parameter for calculating U_C

33.-0.5903

34.# U_C2: parameter for calculating U_C

35.4.4345

36. # U_C3: parameter for calculating U_C
37.-11.8633

38. # U_C4: parameter for calculating U_C

39.13.569

40. # Weibull_K

41.1.85

42.# Weibull-A method: Entered directly [1]; Calc.from DAMS [2]
43.1

44 # Weibull_A_Entered

45.6

46. # Params for calc.Weibull-A: A_Weibull = DAMStoWeibullAT + DAMStoWeibullA2 * DAMS
47 # DAMStoWeibullA1

48.-0.9626

49. # DAMStoWeibullA2

50.0.4279

51.# Number of sections in each metre length of trunk
52.1

0 N O AW =



Species parameter files

Species parameter files must be stored in a directory called SpeciesParamPFiles, held in the root
directory of Forest GALES 2.5 (i.e. ForestGALES_2.5\SpeciesParamFiles); it must not be moved
from here. Individual species parameter files are named XXParameters.txt, where XX is the two
letter species code (CP, LP, SP EL, HL, JL, NS, SS, DF, NF, GF, WH). (Forest GALES looks for ..\
SpeciesParamFiles\XXParameters.txt). Three user-defined species are also available in
Research mode, with species codes U1, U2, and U3.

The species parameter file includes:

* 2-characters species code (e.g. SS for Sitka spruce). When 'Save All' is clicked, this code is
written to the output file, to provide a check that the correct species' parameter file has been
used.

Parameters for equations

* Multiplier and intercept for linear conversion from Top height (m) to Mean height (m):

MeanHt = Multiplier*TopHt + intercept

* Parameters to calculate Canopy breadth (m) as function of DBH (m), and code for form of equation.

Code:l Linear Param1*DBH*100 + Param2 [set param3 = 0]

Code:2 Power Param1*DBH"Param2 + Param3

« Parameters to calculate Canopy depth (m) as function of height (m), and code for form of equation.

Code:l Linear Param1*Height + Param2

Code:2 Exponential Param1*exp(Param2*height)

Set values

* Stem density (kg/m?)

* Canopy density (kg/m?)

* Modulus of rupture

* Knot factor

* Modulus of elasticity

* Streamlining parameters: C, N !
* Root bending term: RootBendK ?

!See Equation 12 in Technical appendix
2Normally set = 0.
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Overturning moment calculation

Anchorage coefficients '
For each of the four soil groups (A,B,C,D) there are three anchorage coefficients: one for each
rooting depth (shallow, deep) and one user-defined.

' See Equation 1 in Technical appendix

Maximum stem weight (kg)

For each soil-rooting depth combination, the maximum stem weight is used to raise a warning
to the user for extrapolated values, or where no data were available for the soil/rooting depth
combination.

Refer to the section starting on page 15 of the User guide for information on soil groupings
and rooting depth.

Scaling parameter

A scaling parameter has been included (OTM scaling value) to enable percentage changes to
the anchorage coefficient to be applied, without altering the actual values of the coefficients in
the parameter file. If the OTM scaling value is set at 100, this is equivalent to using the actual
anchorage coefficient.

The structure of the species paramater file is shown on page 45 to 46; this must be adhered to.
* Within the species parameter file, all comment lines begin with #.

* Atintervals, after the #, a line number is given (e.g. L8). These have been included to help
ensure that the file format is correct. They should correspond with the line numbers in the
text editor.

User-defined species

Three user-defined species can be used when working in Research mode. The species
parameter files for these are named UTParameters.txt, U2Parameters.txt and U3Parameters.
txt and are located in the directory SpeciesParamFiles. Simply edit these to contain values for
your own species; the structure is identical to that described earlier.

In Research mode, the Species drop-down menu in the Tree characteristics box of all
Forest GALES modes will show User-defined species 1, User-defined species 2 and User-
defined species 3 at the bottom of the species list. This can be used to select your species.

If you make a batch input file for your user-defined species, the species codes should be
entered as U1, U2, U3. If you are using these species for Predictions using yield models, or
Predictions through time, ensure that you have made corresponding yield tables (see “User-
defined yield models” on P27 of the User manual), stored in the folder yldmodIs\XX\ where XX
is UT, U2 or U3.



# Forest GALES 2.5Res Sitka spruce parameter file

SS

# L3 Conversion Top height (m) to mean height (m): MeanHt = Multiplier*TopHt + intercept
# Multiplier

1.0467

# Intercept

-2.1452

# L8 CanopyBreadth (m) as function of DBH (cm).

# Equation form: 1 linear: Param1*DBH*100 + param2; 2 Power: Param1*DBH"Param2 +

O 0 N oy A W =

Param3
10.1
11, # Param
12.0.1346
13.# Param2
14.0.6418
15.# Param3
16.0
17.# L17 CanopyDepth (m) as function of height (m)= Mulitplier*Height + intercept; (m).
18. # Equation form: 1 linear: Param1*Height + param2; 2 Exp: Param1*exp(Param2*height)
19.1
20. # Param1
21.0.3667
22.# Param2
23.2.4682
24.# L24 Stem Density
25.850
26.# Canopy Density
27.25
28. # Modulus of rupture
29.3.4E7
30. # L30 Knot factor
31.1.0
32.# Modulus of elasticity
33.5.9E9
34.# L34 Streamlining parameters
35.#C
36.2.35
37.#N
38.0.57
39. # Root bending term RootBendK
40.0.0
47.# L41 Overturning Moment Multipliers
42.# Soil-A; Rooting depth 1,2,User
43.153.2
44.178.1
45.156.2
46. # Soil-B; Rooting depth 1,2,User
47.135.8
48.157.9
49.138.5
50. # Soil-C; Rooting depth 1,2,User
51.1483
52.1725
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53.151.2

54. # Soil-D; Rooting depth 1,2,User
55.168.7

56.196.2

57.172.1

58.# L58 OTM Scaling value

59.100

60. # Maximum stem weight in each category (kg)
61. # Soil-A; Rooting depth 1,2,User
62.519

63.893

64.519

65. # Soil-B; Rooting depth 1,2,User
66.2068

67.1042

68. 2068

69. # L69 Soil-C; Rooting depth 1,2,User
70.1205

71.237

72.1205

73.# L73 Soil-D; Rooting depth 1,2,User
74.1070

75.1012

76.1070

Weibull parameters

In previous versions of Forest GALES, Weibull_K was embedded as a constant within the code
and Weibull_A was calculated from DAMS for each site. Using Research mode in Forest GALES
2.5, in the six standard (three single-stand and three batch) modes:

* Weibull_K'is held within the external parameter file FGparameters.txt and can easily be
altered.

* Weibull_A can be read directly from the external parameter file, or it can be calculated from
DAMS if preferred. A code within the parameter file switches between these two options. If
Weibull_A is calculated from DAMS, the variables relating Weibull_A to DAMS can be altered
in the parameter file. See Equation 17 in the Technical appendix.

If you are working in a Batch mode, the same settings apply to all stands in the batch. When
Forest GALES is run, a message appears in the bottom of the open window saying whether
Weibull_A was entered directly or calculated using DAMS.



Batch-Weibull mode

There is also a new mode: Batch-Weibull mode. When Research mode is selected, an icon for
this mode appears at the top of the Forest GALES window (Figure 26). Click this to open the
Batch-Weibull window.

Figure 26 Batch-Weibull mode icon.

Eile Mode DAMS Options Window Help
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This mode uses field measurements (see the sections starting on page 15 and page 30 of
User manual and Table 7), but Weibull_A and Weibull_K are entered individually for each
stand in the Weibull Box (Figure 27).

Figure 27 Weibull box.
[~afeibull

Wheibull A iE-D '¢i
Wheibull K. 11-55 '¢i

Table 7 Summary of derivation of Weibull parameters in each mode.

Single stand modes: Read from parameter file Either calculated from DAMS, or read
field measurement; from parameter file, depending on
yield model; through time code in parameter file

Batch modes: Read from parameter file Either calculated from DAMS, or read
field measurement; from parameter file, depending on
yield model; through time code in parameter file. Weibull_K

and Weibull_A the same for all stands
analysed in one batch

Batch mode: Weibull Entered separately for each stand in the batch
(field measurement) (irrespective of code in parameter file)
Long files

The standard batch modes in Forest GALES 2.5 have a limit of 32994 lines of data. While this is
sufficient for most purposes, on occasion a longer file might be needed. The Batch-Weibull
mode includes a feature allowing files of unlimited length to be read in. Files in Batch-Weibull
mode are of the type *.bmw. For guidance of how to easily create a batch input file, refer to
Creating batch input files on page 31.

Open Batch-Weibull mode
Select the Field measurements - Weibull: batch mode window
Click the Run long file button (or Alt + L)

Select the file and click Open

RESEARCH MODE
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Forest GALES will then process the selected file. Outputs are automatically saved as a *.csv file
with the same name and in the same directory as the input file.

Outputs

In addition to the basic outputs saved in Normal mode of Forest GALES 2.5 [Save Outputs
button; See Table 5], in Research mode there is a Save All, which saves inputs, and basic and
detailed outputs (Table 8).

In Batch mode using field measurements, Batch mode using yield models, and Batch mode
using Weibull parameters, Save All saves information for all stands included in the batch.

For predictions through time, Save All is available in Single stand mode, and in Batch mode when
you double-click a single row of data to view outputs for an individual stand. Clicking Save All at

this point will save information for the selected stand. The outputs saved are shown in Table 6.

To use Save All, click on the button when calculations have completed. Specify a filename
and path of your choice.

Note: If you wish to use Save All for a given run of Forest GALES, do so before running the model
again, as the default output file is automatically overwritten each time the program is run.

Table 8 Outputs saved using Save all button in Research mode.

_m Weibull | Through time* | Through time

StandID Age Overturn WDRST
Species Age Overturn WDRS2
Yield class (m3/ha/yr) Age Overturn WDRS3
Thinning regime Age Overturn WDRS4
Initial spacing (m) Age Overturn WDRS5
Model used Age Overturn WDRS6

Species file used

Age Break WDRST

Soil group Age Break WDRS2
Rooting depth Age Break WDRS3
Spacing (m) Age Break WDRS4
P Year Age Break WDRS5
Year of calc Age Break WDRS6
DAMS

Age (yr)

Top height (m)

DBH (cm)

Mean vol (m3)

Vol per ha (m3/ha)

Gap size (m)

CWS! overturning (m/s)
Return period over (yr)
WDRS overturning
CWS! breakage (m/s)



Return period breakage
(yr)

WDRS breakage

CWS' damage (m/s)

Return period damage
(yr)

WDRS damage
Mode of damage
Mean height (m)
Canopy width (m)
Canopy depth (m)
Crown base (m)
Stem wt (kg)

Stem vol (kg/m?)
Branch wt (kg)
Branch vol (kg/m3)

Max. overturning
moment (Nm)

Max. breakage moment
(Nm)

CWS overturning at
canopy top? (m/s)

CWS breakage at canopy
top? (m/s)

Gustiness
Edge factor

Gust factor (Edge factor *
Gustiness)

ZPD (m)

Z0 (m)

Drag coefficient
A-Weibull
K-Weibull
A-Weibull method

Comments

* For Through time, outputs in the table listed from Age downwards are output for each age
in the selected yield table. The values for ‘Age to reach WDRS 1-6 apply to the whole rotation.

T CWS is critical wind speed at 10 m above zero-plane displacement.

2 Canopy top is mean tree height.

x

X

X

X

X

X

X

X
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Glossary

Anchorage The complex of mechanisms by which the root system and soil resist the wind
forces on the stem and crown.

Brown edge An edge of a stand that was created by felling part or all of the adjacent crop,
rather than being a crop boundary since the time of planting.

Centre of pressure The average position in the crown of the tree where the total force
of the wind can be said to act.

Coherent gusts Organised rotational motions in the air (= Vortices).

Critical wind speed Threshold hourly wind speed above which the average tree of a stand
is expected to be overturned or snapped.

Critical height The top height of the stand at which damage was expected to start within
the WHC system.

Cultivation The method of preparing the soil prior to tree establishment. This may have been
done by many means such as ploughing, mounding or producing turves.

Damping The processes by which oscillations are reduced in size and tend to stop. Damping
includes canopy clashing, canopy drag through the air, and frictional movement of stem
fibres.

DAMS score Detailed Aspect Method of Scoring - a system for scoring windiness derived
from tatter flags and using representation of location and terrain to calculate a score.

DBH Diameter of a tree at 1.3 m above ground level.

Dominance The 'social’ status of a tree within a crop. Five categories are usually defined -
dominant (trees with a crown entirely within the canopy), codominant (trees with much
of their crown in the canopy), subdominant (trees with their crowns generally below the
canopy), suppressed (trees with small crowns entirely beneath the canopy, which are
gradually dying from lack of light) and dead.

Drag area The surface area of the tree (canopy and stem) presented to the wind. Drag area
is reduced as wind speed increases, due to streamlining of the tree.

Drag force The force on the tree caused by the pressure exerted by the wind on the crown
(= wind loading).

Drainage A description of site wetness; poor refers to a wet site where rooting is severely
restricted by a shallow watertable - due to local topography or failure of/lack of installed
drainage system; good refers to better than average site - due to topography (e.g. shedding
slope) or good quality intensive drainage network.

Frequency of oscillation The number of sway cycles of the tree per second.

Fulcrum The position on the lee-side of the tree where the root system pivots when the tree
is bent by the wind (= hinge).

General yield class An index used in Britain, expressing the potential stem volume productivity
of even-aged stands of trees (in units of cubic metres per hectare per year), based on an
assessment of top height at a given stand age.

Gust A rapid increase in wind speed over a short period of time (seconds rather than minutes).

Gust factor Ratio of the maximum turning moment to the mean turning moment on a tree
from wind over the period of an hour.

Hinge See Fulcrum.

Leeward The side of the tree facing away from the wind.

Lever The distance between the point of action of a force and the fulcrum.

Modulus of elasticity A measure of stiffness. Modulus of elasticity is the load that theoretically
would be required to make a material double (or halve) in length were it to behave
perfectly elastically. In practice timber generally stops behaving elastically when its length
changes by 1% and breaks when the change exceeds 2%.



Modulus of rupture The force per unit area that is required to break a material when
a bending load is applied.

Moment Force multiplied by distance (= torque).

Overturning moment The force on the tree multiplied by the distance from where the force
acts (the centre of pressure) to the fulcrum, plus the additional moment due to the weight
of the over-hanging crown.

Risk (for a tree) The probability in a particular year of the critical wind speed being exceeded
(see Vulnerability).

Risk status A measurement of the probability of the critical wind speed being exceeded
in a particular year, grouped into six categories. Status 1: return period >100 years; Status 2:
return period 50-100 years; Status 3: return period 33-50 years; Status 4: return period
20-33 years; Status 5: return period 10-20 years; Status 6: return period <10 years.

Root architecture The appearance and structure of the root system, particularly the number
and arrangement in three dimensions of the thickest roots.

Rooting depth The average maximum depth of tree roots below the soil surface. On many
sites this is constrained by limiting soil conditions such as a water table, induration or the
underlying bedrock. Rooting depth may be measured in a soil pit, or estimated based on
soil type and conditions.

Spacing - Current The average spacing between trees at the time of risk assessment.

Spacing - Initial The average spacing between trees at the time of planting.

Stocking The number of trees per hectare at the time of risk assessment.

Terminal height The top height of a stand at which wind damage was expected to reach a
level necessitating clearance.

Thinning The removal of a proportion of the tree crop for silvicultural or economic reasons.
Forest GALES can extract data from yield models categorised according to thinning regime
and initial spacing. The regimes used in the yield models are non-thinning (no trees actively
removed, though some may die naturally), intermediate thinning (removal of trees from
throughout the crop, with the smaller trees being preferentially removed), line thinning
(removal of trees in straight lines) and crown thinning (removal of trees that are competing
with the crowns of the highest quality trees). Models have also been produced for delayed
thinnings.

Top height The average height of the 100 trees of largest diameter per hectare, usually
measured as the average height of the largest diameter trees in a sample of 0.01 ha plots.

Topex A measure of exposure based on the sum of the angles to the horizon in eight compass
directions.

Turbulence The random variations in wind speed and direction.

Vortices See Coherent gusts.

Vulnerability The threshold wind speed required to blow over a particular tree on a particular
site.

WHC See Windthrow hazard classification.

Wind loading See Drag force.

Windthrow hazard classification A method to zone forest areas of 500 ha or more by adding
classification scores for windiness and soil together to estimate a hazard class. Each class
was associated with a critical height and a terminal height.

Windward The side of the tree facing towards the wind.

Wind zone A range of windiness categories for the whole of Britain. The higher the wind zone
the windier the climate on average.
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Further reading and useful sources
of information

Forestry Commission publications
www.forestry.gov.uk/publications

* Forest mensuration: a handbook for practitioners (FCBK039)

* Forests and wind: management to minimise damage (FCBU114)

* Rooting and stability in Sitka spruce (FCBU040)

* The identification of soils for forest management (FCFG0O1)

* Forest Yield: a PC-based yield model for forest management in Britain (FCSWO002, in prep)

Other publications
* Wind and wind-related damage to trees (Cambridge University Press)
* Joint evaluation of storms, forests vulnerability and their restoration. Discussion Paper 9

(European Forest Institute)
* Living with storm damage to forests: what science can tell us 3 (European Forest Institute)

Websites

* Forest GALES - www.forestry.gov.uk/fr/forestgales


http://www.forestry.gov.uk/fr/forestgales

Technical appendix

Critical turning moments for overturning
and breakage

The critical turning moments for overturning and breaking of a tree can be derived using the
formula in Gardiner et al. (2000):

1 M crit_over = Creg SW

2 Mcrit,break:E'fknot'MOR°diam3
32

where M is the total overturning moment (in Nm, resulting from wind loading and from the
weight of the overhanging crown) and diam is the diameter of the stem (m). M is calculated
at the base of the tree (diam = do) for overturning and either at the base of the tree or at
breast height (diam = dbh) for stem breakage. SW is the weight of the bole of the tree (kg)
multiplied by an average green density value (typically 850-1000 kg m=). The remaining
parameters are species-specific: C.y (Nm kg'') is an anchorage coefficient obtained from tree
pulling experiments, and is a function of species, soil type and rooting depth. The C, values
used in Forest GALES 2.5 were derived from reanalysis of data presented in Nicoll et al.
(2006), and provide a more consistent change in value for different depths of rooting than
the values presented in that paper. The parameter fi« is a factor to reduce wood strength
due to the presence of knots (usually between 0.8 to 1; Ruel et al,, 2010); and MOR is the
green wood Modulus of Rupture (Pa) for the particular species, derived from bending tests
(e.g. Lavers, 1969).

Gardiner et al. (2000) and Quine and Gardiner (2007) showed that the mean bending
moment at any height (z, in m) on a tree can be derived from the aerodynamic stress on the
forest canopy (7= pv.2), the average spacing between trees (D, in m) and the assumption
that the wind loading acts on average at the height of the zero-plane displacement (d, in m;
Thom, 1971):

3 Miean (z) =(d - 2) pu.? D?

where v.is the friction velocity (m? s?) and pis air density (kg m=). This can be used to
calculate the turning moment on a tree at height z above the ground in terms of the canopy
top wind speed (u(h), m s) by assuming a logarithmic wind profile above the canopy
(Gardiner et al., 2000; Quine and Gardiner, 2007):

Du(h)k
In [hz—od]

where h is the average tree height (m), o is the aerodynamic roughness (m), and k = 0.4 (Von
Karman's constant). This is then converted into a calculation of the maximum turning moment
by multiplying by a gust factor (G):

2

4 Minean (Z) = (d - Z) 1Y

Du(h)k)®

h-d
In Z_o]

Muox(2)=fou(d-2) PG

where faw is a factor to account for the additional moment provided by the overhanging
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displaced mass of the canopy. This can be calculated directly using the tree bending equations
described by Neild and Wood (1999) (their Equation 7) if the force of the wind (pv? D?),
the point of action of the wind (d) and the mass distribution with height in the tree are known.

A gust factor (G) is required because the maximum wind loading occurs during short-term
gusts of a few seconds, but maximum wind loading is predicted from the mean hourly wind
speed u(h) in order to match with standard climatological wind data. G is the ratio between
maximum and mean turning moment and is calculated as a function of the spacing to tree
height ratio, based on wind tunnel measurements (Gardiner et al., 1997). The original formula
used by Gardiner et al. (2000) was found to be unstable at low values of D/h (close spacing)
and was replaced by the following equation, which gave a more robust fit to the data:

6 G=[(-2.1-D/h+0.91)+x/h+(1.0611In(D/h)+4.2)]- gfadj
where x is the distance from the forest edge (m). Note that it is necessary to ensure that
-2.1+D/h+0.91 = 0. The factor gfadj = 1.0 replaces the value of 1.5 used in versions

of Forest GALES, which was found during a comparison against observed damage to give
critical wind speeds that were too low (Hale et al., 2015).

Aerodynamic parameters

The aerodynamic parameters in Equation 4, z, and d, can be calculated using the method
of Raupach (1994):

7
d=h[1 _|1-exp(- vedl-A)
vedl-A
8 zo=(h-d)-exp(-k=y+s)
9 A=2|canopybreadth canopydepth « Cp / D?
2
10 y= 1— max A=0.6
=
1
11 =In (C,)-1+—
Yr=In (C.) c

where cd1=7.5, Cs=0.003, Cz=0.3 and Cy=2, canopybreadth is the maximum width of
the canopy (m), canopydepth is the length of the live crown (m), and Cp (drag coefficient)
is a measure of the streamlining of the crown in the wind, which can be calculated from
the experimental data in Mayhead (1973), Rudnicki et al. (2004) or Vollsinger et al. (2005):

12 CD=C'U_n

where u is the wind speed of interest (m s). As examples, C=2.35 and n=0.51 for Sitka spruce
and C=3.07 and n=0.75 for Scots pine with a maximum value of drag coefficient set at

u=10 m s and a minimum value at u=25 m s™'. Note that we divide the value of
canopybreadth by 2 to get the average canopy width for the tree because we assume a
rhomboid shape for the crown with the maximum width of the canopy defining the width of
the rhomboidThe AEP for a particular critical wind speed (Windspeed) is given by:



Critical wind speed

By equating Equations T and 2 with Equation 5 it is possible to calculate the critical wind speed
at canopy top for overturning and stem breakage (U(h)ci over aNd U(h)crit prear, respectively, in ms™):

13 () = 1 [M]WV ]W " [h_d]
kD| pGd cw %o

y ulh), = [w]’” [f_k"‘”]w In [h—_ d]
kD[ 32pG(d-1.3)] lf,, %

These equations have to be solved iteratively because porosity is a function of wind speed and,
therefore, so are d and z,. These critical wind speeds need to be converted to the corresponding
wind speeds at 10 m above the zero plane displacement (u(d+10).) in order to utilise
meteorological data to calculate probabilities of occurrence and return periods:

15 u (d+10)cre= u(h)cri-

where U is either u(d+10)i over OF U(d+T0) it break.

Return period

The return period for this critical wind speed (u(d+10).:) can be calculated from the Weibull
distribution, which describes well the wind speed distribution at individual locations in Britain
(Cook, 1985); the Weibull shape parameter (Weibull_K) is relatively constant (~ 1.85), and the
scale parameter (Weibull_A) is related to the mean wind speed (WS,.») through the expression:
16 WS mean=Weibull_A-T'(1+1/1.85)=Weibull_ A-0.838

where T is the gamma function (see Troen and Petersen, 1989).

The Weibull parameters are used to calculate the annual exceedance probability of the critical
wind speed. In Forest GALES 2.5 Standard mode, Weibull_K is set at a constant value of 1.85,
and Weibull_A is calculated from DAMS as follows (Quine, 2000):

17 Weibull A=a-DAMS-b

For the forested areas where this relationship was parameterised, values are:

a=0.4279

b=-0.9626
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In the Research mode of Forest GALES 2.5, Weibull_A and Weibull_K can be entered directly
by the user.

To calculate the annual exceedance probabilbity (AEP) we use a method developed by ESDU
that links the Weibull distribution to the Fisher-Tippet Type 1 extreme value distribution.

The AEP for a particular critical wind speed (Windspeed) is given by:

18 AEP=1-exp [— exp[—1[_lg—‘/\/"r'dS eedz—U]”
U/ u,

where (from Quine, 2000):
19 U C=U_C1+Weibull_K3+U_C2+Weibull_K?+U_C3+*Weibull K+U_C4
20 U=(Weibull_ A*U_C)?

The return period (average number of years between damaging events) is given by 1 / AEP.

with:
U_C1=-0.5903
U_C2 =4.4345
U_C3=-11.8633
U_C4=13569

and U, is taken as equal to 5 (Quine, 2000).
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Wind damage is a major challenge for the management of forests in Britain, and it has economic,
environmental and social consequences. In some areas the threat of wind damage restricts
silvicultural options and leads to the use of shortened rotations, giving lower income from timber
sales. In order to minimise risk, forest managers need information on the likely timing and
magnitude of damage so that they are able to predict the level of risk and assess the implications
of different management options. Forest GALES draws together more than 30 years of knowledge
and research into a user-friendly decision support tool that will enable forest managers to
estimate the probability of wind damage to conifer stands in Britain. The software calculates the
wind speed that would be expected to damage a stand of frees and it provides windiness scores
(DAMS) for the whole of Britain. It assesses the current level of risk of overturning and stem
breakage, and the change in risk over the lifetime of the crop, in addition to assessing the effect
on risk of thinning and the creation of brown edges. Forest GALES is able to calculate the risk to
any number of stands simultaneously.
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